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1.0 SeisOpt® ReMi Software Overview  

SeisOpt ReMi software uses refraction microtremor recordings from standard refraction equipment 
to estimate 30 m (100 ft) average shear wave velocities and one- and two-dimensional shear wave 
profile down to depths of 100 m with 5%-15% accuracy, with the accuracy decreasing with depth. 
The software is based on the refraction microtremor (ReMi) technique described by Louie (2001) 
(http://www.optimsoftware.com/white_papers/images/remi.pdf). A field tutorial on how to acquire 
ReMi data is provided in the insert of this user's manual. Before collecting the data for ReMi 
software analysis, please read the field tutorial carefully and contact support@optimsoftware.com

 

with any questions about the acquisition parameters. The frequency of the available geophones, 
distance between geophone takeouts, total length of the recording array, and the distribution of 
subsurface velocities will determine the maximum depth up to which shear wave velocities can be 
derived.  

Current techniques of estimating 30 m (100 ft) average shear wave velocities (Vs100 ) and one-
dimensional shear velocities for assessment of earthquake site response are too costly for use at most 
construction sites. They require large sources to be effective in noisy urban settings, or specialized 
independent recorders laid out in an extensive array. SeisOpt ReMi software uses microtremor noise 
recordings made on 200-m-long lines of seismic refraction equipment can estimate shear velocity 
with 5-15% accuracy, often to 100-m depths. Shorter lines and higher frequency geophones will 
yield velocities down to shallower depths. It uses standard refraction equipment, simple recording 
with no source, a wavefield transformation data processing technique (ReMi Vspect module, see 
Section 3.0), and an interactive Rayleigh-wave dispersion-modeling tool (ReMi Disper module, see 
Section 4.0). Thus, the refraction microtremor exploits the most effective aspects of the microtremor, 
spectral analysis of surface wave (SASW), and multi channel analysis of surface wave (MASW) 
techniques (Louie, 2001). The slowness-frequency (slowness is inverse of velocity) wavefield 
transformation is particularly effective in allowing accurate picking of Rayleigh-wave phase-velocity 
dispersion curves despite the presence of waves propagating across the linear array at high apparent 
velocities, higher-mode Rayleigh waves, body waves, airwaves, and incoherent noise (Louie, 2001).  

2.0 Installing and Getting Started with SeisOpt ReMi  

2.1 Installing SeisOpt ReMi  

Begin the installation of SeisOpt ReMi by inserting the installation CD into the CD drive. The install 
process should start automatically. If it does not, you can go to the CD drive and click on the 
Setup.exe file, which has the icon, shown in Figure 1.  

 

Figure 1: Setup.exe icon. Click this to start the installation, if it does not start automatically on 
insertion of the install CD into the CD drive.  

When the install is complete, a Setup Complete window will pop open. You have the option of 
choosing to read the README file or clicking on 'Finish' to end the installation. The README file 
gives you directions on how to obtain your license from Optim to run SeisOpt@2D. The default 
installation directory is C:\Optim\ReMiv30\.  A successful installation will create three SeisOpt 
ReMi desktop icons, as follows:  

http://www.optimsoftware.com
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SeisOpt ReMi Vspect module (Figure 2a, see Section 3.0), which has tools to read in the 
recorded data and create a Rayleigh wave phase-velocity dispersion curve.  

 
Figure 2a: SeisOpt ReMi Vspect module icon  

 

SeisOpt ReMi Disper module (Figure 2b, see Section 4.0), which is the interactive, one-
dimensional shear wave velocity-modeling tool.  

 

Figure 2b: SeisOpt ReMi Disper module icon  

 

SeisOpt ReMi Registration tool (Figure 2c), which has to be used to register the software before 
use. 

 

Figure 2c: SeisOpt ReMi Registration icon  

2.2 Authorizing and Registering SeisOpt ReMi   

SeisOpt ReMi software modules are protected by encryption software and so you need to obtain the 
proper authorization from Optim to be able to start using them. The following sections outline this 
procedure:  

2.2.1 Registering SeisOpt ReMi software    

1. The first step is to register SeisOpt ReMi. Note that you can do the authorization and registration 
at the same time. That is, send the registration key (Section 2.2.1 and site code at the same time 
to Optim. 

2. To register double-click on the Register_ReMi icon (Figure 2c) that appears on the desktop 
after installation.  

3. A command (MS-DOS) window will open up (Figure 3), displaying the Registration Code .  
4. Send this code, along with your company name and address to Optim, via email to 

support@optimsfotware.com, phone or fax. 
5. DO NOT quit the registration window until after you have entered the registration key. Else, you 

will not be able to run this module. 
6. A registration key will be returned, which you will need to enter to authorize the program. 
7. On successful registration window will either automatically close or you can close the window.  

http://www.optimsoftware.com
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Figure 3: A command (MS-DOS) window opens up with the Registration Code

  

2.2.2 Authorizing SeisOpt ReMi Vspect and Disper Modules  

The next step is to authorize the license for SeisOpt ReMi Vspect and Disper modules. Note that you 
can do the authorization and registration at the same time. That is, send the registration key (Section 
2.2.1 and site code at the same time to Optim. To do so, following the steps below:  

1. Copy the file Cks.exe that is present in the installation CD to the install directory 
C:\Optim\ReMiv30\ 

2. If you are installing and running SeisOpt ReMi on a Windows NT, 2000, or XP machine you 
need to log in as the local administrator and run setupex. Find the setupex file in the 
installation directory (globe icon show in Figure 4). Run setupex by double clicking the globe 
icon from a Windows-explorer window.   

 

Figure 4: Setupex icon. Double-click on this after installation, if the host is an NT, 2000, or XP machine.  

3. Click on the ReMi Disper icon (Figure 2b) on the desktop.  
4. When the license configuration window appears (Figure 5), a Site Code should be displayed, as 

shown in Figure 5. If not, click the Display Site Code  button.  

Email this code to support@optimsoftware.com. 
DONOT close the window until you enter the 
registration key 

http://www.optimsoftware.com
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Figure 5: License configuration window for ReMi Disper module displaying the 'Site Code'  

5. Send this site code to Optim, by email (support@optimsoftware.com), phone (775.784.6613), or 
fax (775.784.1833).  This same Site Code will reappear each time the license configuration 
window is opened until a Site Key is entered. 

6. Upon receiving your Site Code, Optim will generate a Site Key and send it to you.  Enter this 
Site Key in the blank line below the site code, and click Validate .  

7. Each time you run ReMi Disper, a small window briefly appears (Figure 6) describing the status 
of the license, then closes, and the program starts. DO NOT hit ENTER/RETURN when this 
window appears.  

 

Figure 6: License check window appears each time ReMi Vspect or ReMi Disper module is run  

8. SeisOpt ReMi will not run on any other computer, without obtaining another Registration Key 
and Site Key or authorization to transfer the license (sees Section 6.2).  

2.2.3 Preventing loss of license  

SeisOpt ReMi Disper module software protection mechanism works by storing hidden files in the 
PC. As a result, the user should make sure these files are not erased during disk de-fragmentation or 

Email this to 
support@optimsoftware.com

 
and enter the site key sent 
back to you in the appropriate 
location
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while running an anti-virus scan. For example, this is known to happen when running Speed Disk, a 
de-fragmentation utility included in Symantec s Norton Utilities. This also happens while running 
Norton Anti-Virus Utility. Loss of these files will result in the loss of license to run SeisOpt.  
To prevent this loss, do the following:  

1. Open Speed Disk, and choose File, Options, Customize, and Unmovable Files. 
2. Specify that the *.ENT, *.RST, .KEY, and.41S files cannot be moved.  

3.0 SeisOpt ReMi Vspect Module  

Double-click on the desktop icon shown in Figure 2a to launch the ReMi Vspect module. The 
graphical user interface shown in Figure 7 will open up. The Vspect module imports the microtremor 
data recorded in the field and performs a wavefield transformation, creating a velocity spectrum 
in the slowness-frequency (p-f) domain.   

 

Figure 7: Starting graphical user interface of SeisOpt ReMi Vspect module  

This module contains tools to do the following:  

 

Convert refraction microtremor data recorded in the field (SEG-2 format) to SEG-Y. 

 

Import, visualize and plot the data (Step 1). 

 

Perform some pre-processing on the data (Step 2). 

 

Erase or apply geometry to the microtremor records (Step 3). 

 

Perform wavefield transformation on the data in and generate a velocity spectrum in the 
slowness-frequency domain (Step 4). This yields the Rayleigh wave phase-velocity dispersion 
curve. 

 

Visualize and plot the velocity spectrum.  

 

Stack and sum velocity spectrum from individual records (gathers) to one spectrum (Step 5). 

 

Pick the dispersion curve and export the picks for interactive one-dimensional velocity modeling 
using SeisOpt ReMi Disper module (Step 6).  

 

In addition it has also options to write out images in JPEG, SEG-Y, or Binary formats. 

http://www.optimsoftware.com
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Each of these steps launches a new window. For ease of use it is recommended that the user close 
any windows that are not needed, by selecting Close Window under the File menu. That is, 
for example, if the user is performing Step 4, he or she can close windows that were opened during 
Step 1, Step 2 and Step 3.   

Note that the title bar on each window indicates which step of the SeisOpt ReMi Vspect processing 
the user is at, making it easier to keep track of the processing sequence. When proceeding to the next 
step, use the select the options from the current window. If you do have windows from all the 
processing steps open, click on the frame of the window you want to activate and bring to the front.  

3.1 Step 1: Converting, importing and visualizing field data  

The first step is to convert the microtremor data recorded in the field to SEG-Y format since current 
version of the ReMi Vspect module can only read in field data in SEG-Y format. If the seismic 
recorder can save data in SEG-Y format, then this step can be skipped.   

For the convenience of the user, the module comes with a program that will convert data recorded in 
SEG-2 format to SEG-Y. If you wish to convert other data formats to SEG-Y (like from ABEM 
Mark 3 or OYO), use SeisOpt® Picker which is available from Optim. SEG-2 (usually, with .DAT 
extension) is the format of data recorded by several seismographs and is one of the most common 
formats used for recording seismic data. The conversion program can handle only data that has 
16,000 samples per trace or less. Hence, set the recording length and sampling rate to make sure this 
limit is not exceeded. Contact support@optimsoftware.com

 

if you have any questions before 
acquiring the data. There are several commercial programs available (for example, IXSeg2Segy © 
Interpex Limited, Golden, CO, USA) that can handle longer trace data.  

3.1.1 Converting SEG-2 data to SEG-Y format 
If your seismograph records in SEG-2 format, then the first step is to convert it to SEG-Y format. To 
do so, choose the Convert SEG2 Files to SEGY item from the File menu of the Vspect module, 
as shown in Figure 8. 

 

Figure 8: Choose Convert SEG2 Files to SEGY to start the process of converting SEG-2 files 
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The dialog window shown in Figure 9 opens up, with the message Select first SEG File in its 
title bar. Go to the directory containing the SEG-2 data files (.DAT extension) and choose all the 
records that need to be converted. Make sure all the files that are being converted are recorded along 
one profile. Note that for this example, the data files RM2011.DAT to RM2021.DAT residing in the 
subdirectory demo was chosen.   

 

Figure 9: Choose all the SEG-2 files to be converted and click Open

  

If the conversion is successful, a window displaying the message Conversion completed will 
open up (Figure 10).   

 

Figure 10: On successful conversion, the message above will be displayed on a Notepad/Wordpad 
window  

Any errors that might occur during the conversion are also displayed in this window. A SEG-Y file 
(.SGY extension) containing all the files (records) and which has the name of the first SEG-2 file 
will be written to the directory containing the SEG-2 files.  The conversion is almost instantaneous 
(few seconds) and so, if the window shown in Figure 10 does not appear, it indicates a problem in 
converting the files. If this is the case, try converting one file at a time. This will create one SEG-Y 
file for each SEG-2 file. The individual SEG-Y files can then be read in together in Step 1 of the 
Vspect processing sequence (Section 3.1.2). 

http://www.optimsoftware.com
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The conversion is performed by the seg2segy routine, slightly modified to adapt to Vspect module, 
and is available from the Colorado School of Mines (Copyright, 1992-1999). The following rules 
and limitations apply to the conversion:  

 
The SEG-2 files should not exceed 16,000 samples per trace. For a typical SeisOpt ReMi data 
acquisition, it is sufficient to record for 30 seconds, at 2 ms sample interval, resulting in 15,000 
samples per trace. One can record noise for 30 seconds at 2 ms sample interval and the data can 
be converted using the above module.  

3.1.2 Importing and Visualizing SEG-Y Files  

Once the SEG-2 files have been successfully converted to SEG-Y format, the next step is to import 
and visualize them using the ReMi Vspect module. You also use this step to read in individual  
SEG-Y files (records) that have been recorded in the field. To do so, go the Vspect Process menu 
item and choose Step 1.b: Open SEG-Y Seismic Records as shown in Figure 11.  

 

Figure 11: Choose Step 1.b: Open SEG-Y Seismic Records to read in the microtremor data in 
SEG-Y format  

Note that Step 1.a should be used only for data saved or recorded in a format that is NOT SEG-Y or 
SEG-2.   

When the Step 1.b is selected, the dialog box shown in Figure 12a will open up. Go the directory that 
contains the data file in SEG-Y format, select it, and click Open . If you are reading in individual 
SEG-Y files created in the field then you simply choose all the SEG-Y files to be read in as show in 
Figure 12b. Note that you use this option only when each SEG-Y file contains only ONE record. If 
they contain multiple records, see Section 3.1.5 on how to read them in.   

In both cases, the format verification window shown in Figure 13 will open up. The default data type 
of the converted SEG-Y traces is 32-bit integer. Use this the option when the SEG-Y file is created 
using the SEG-2 conversion module (Section 3.1.1) or when using DAQLink II or the SeisOpt ReMi 

http://www.optimsoftware.com
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recording unit manufactured by Seismic Source Company. The program can also read in SEG-Y 
data whose traces could be in any of the formats listed in Figure 14. Usually, the seismic recording 
instrument manual should specify the trace type of the data being recorded. Next, make sure the 
number of traces to be read in is correct. The default value is 24, but if you have a 12-channel system 
this should be changed to 12. Similarly, when recording more channels this should be change to 
reflect the total number of traces being analyzed. Click Read Binary to read in the SEG-Y data.  

 

Figure 12a: Choose the SEG-Y file to be imported in ReMi Vspect for analysis 

 

Figure 12a: When reading in several individual SEG-Y files, each containing only ONE record, select 
all of them and click Open . 

http://www.optimsoftware.com
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                           Figure 13: SEG-Y data verification window. The default trace data type (32-bit integer) 
may needed to be changed only if the SEG-Y data is created by a process other than the one described 

in Section 3.1.1  

 

Figure 14: Different Trace Data Type can be chosen using the pull-down menu  

Enter the number of traces or 
channels (equal to number of 
geophones) to be analyzed. For 
the demo data set this should be 
changed to 36

 

The field record numbers can 
be erased and left blank. This 
will ensure all data is read in.
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Figure 15: (a) SEG-Y data imported into ReMi Vspect module (Step 1) (b) Scroll down the bottom of 
the data to make sure that the total recording time and the amplitude of the traces are correct. An 

incorrect trace data type will result in very large amplitudes for the traces   

For example, if the SEG-Y traces were created by a procedure other than the one described in 
Section 3.1.1 then it is recommended that the user change the trace data type to either IEEE or IBM 
float. One can detect if the trace data type is correct by looking at amplitude scale (Figure 15b) of the 
data. Incorrect trace data type will result in amplitudes being very large (e.g. 1e-8 to 1e+8).  

The data will open up as shown in Figure 15. Do the following to check for integrity of the imported 
data:  

1. Make sure to scroll down to the bottom of the window to check that the total recording time, 
displayed in seconds, is correct (for this example it is 20.48 seconds).  

2. Check the amplitude scale and make sure they are reasonable. Incorrect trace data type will result 
in very large amplitudes.   

Click on the Animate button or use the scroll bar to view all the files (records) that were 
converted. The SEG-Y file should contain all the SEG-2 files that were converted. The Plane 
Index counter will increment from 0 as each record is displayed. For example, for the demo 
data 11 planes (Plane Index 0 to 10) consisting of SEG-Y data from records RM2011 to RM2021 
will be present.  

Note that messages will appear on the MS-DOS window, while the data is being read in, including 
any error messages. Since SeisOpt ReMi Vspect user interface is Java based, it is possible that an 

Out of Memory error might appear when reading in large data sets, with multiple records. As a 

Scroll down to check whether the total 
recording time (20.48 s in this case) is correct 

Check if the total number of traces for 
each record has been read in correctly 
(36 in this case)  

Use the Plane Index scroll 
bar to view all the records that 
were converted. Each plane is 
one record comprising of, in 
this case 36 traces
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rule of thumb, the available RAM on the machine must be about four times the number of bytes in 
the SEG-Y file. See Section 6.0 on how to increase available RAM for Java.  

The data size of the display window can be adjusted by choosing an appropriate zoom percentage 
under View menu (Figure 16).  

 

Figure 16: Adjust window size using the Zoom options under the View menu  

3.1.3 Setting Plot Parameters of the Imported Data  

The parameters that control the display of the data on the window and the output can be viewed and 
edited by choosing the Plot Parameters option under the Edit menu (Figure 17). Choosing 
this will open up the plot property window shown in Figure 18. If the window panel does not look 
like the one show in Figure 18, or if it appears to be missing the lower items, just drag a corner with 
the mouse to enlarge it a little. Setting the plot parameters correctly for the record will allow you to 
analyze it more quickly, as some of the geometry information will be correctly set as well. The 
following describes the plot parameters:  

 

Rows Point Down: If checked, renders the image with the time axis going downwards. 

 

Vert. Exagg. (Recommended between 0.01 and 0.1): controls the size of the plot.  

 

Positive Only: If checked, renders only positive amplitudes. 

 

Amplitude Clip: Values above this are clipped. Best to set it at ``3*rms''  

 

Units: Type in label for scale of image. 

 

Color Table for Image: Choose different color palettes for the image.  

 

Element Zero: Starting time for traces 

 

Element Delta: Sampling interval of the traces in seconds  

 

Element Units: Label for the time axis.  

 

Vector Zero: Starting value for horizontal axis (number of traces or distance). 

 

Vector Delta: Geophone spacing (in meters) or trace spacing.  

 

Vector Units: Label for the x (horizontal) axis (e.g.: Offset, meters' ).  

 

Planes Zero: Index for start of planes, if multiple gathers (records) are being displayed. 

 

Planes Delta: Increment for labeling subsequent planes.  

http://www.optimsoftware.com
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Figure 17: View and edit plot parameters for the display of data by choosing Plot Parameters 
under the Edit menu  

Click the Apply Changes button for the changes to be applied. Click Reset Values to delete 
the changes and Cancel to close the window.   

 

Figure 18: Edit and save plot parameters  

The plot parameters can be saved to file by choosing the Save Parameter File option under the 
File menu of the properties window. A new dialog appears asking you to find a directory and 

suggesting a name for the parameter file. A saved parameter file can be read in using the Open 
Parameter File option.  

3.1.4 Exporting Data Files for Printing  

To save or print a plot of the record, display the appropriate record the, and then select File->Write 
PostScript File... from the menu bar (Figure 19). Note that only the displayed file will be output as 
a PostScript file. If multiple files are present, the correct file must be first displayed by choosing 
using the Planes Index scroll bar at the top. PostScript files can be either displayed, edited or 
printed using drawing programs like Adobe Illustrator. To view and/or print these files a program 

http://www.optimsoftware.com
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capable of reading EPS format files is needed. If you do not have such a program, you can download 
a set of free ones, called GhostScript (Copyright © Aladdin Enterprises) and GSView (Copyright © 
2000 Ghostgum Software Pty Ltd.), from www.cs.wisc.edu/~ghost/. GSView is the visual interface 
to GhostScript. See Section 3.4.5 on how to import the PostScript file into an MS-WORD document. 
Version 2.0 allows to you output the file in JPEG format. Select File->Write JPEG File from the 
menu (Figure 19) to output the rendered image in JPEG.  

 

Figure 19: Write PostScript File option outputs a PostScript file of the data displayed in the user 
interface while Write JPEG File writes out a jpeg image.  

3.1.5 Importing/Exporting files in another format and combining SEG-Y files  

Use the Step 1.a. Open non SEG-Y and non SEG-2 Seismic Records option under Vspect 
Process if you are importing data that is not in SEG-Y or SEG-2 format. When doing so, make sure 
you choose the correct binary file type option.   

There could also be a situation where you need to combine SEG-Y files created by converting group 
of SEG-2 files (using the conversion module), into one SEG-Y file.  That is you need to combine 
several SEG-Y files, each containing multiple records.  This Section describes how to do this.  

Read in each SEGY file using the Step 1.b.: Open SEG-Y seismic records option under Vspect 
Process option. From the window that displays the SEG-Y record, choose the Write Binary 
File . option under the File menu as shown in Figure 19a.  

Write out image in window as a 
JPEG file 

Write out image in window as a 
PostScript file 

http://www.optimsoftware.com
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Figure 19a: Choose the Write Binary File option to export the SEG-Y file as a binary file.  

The dialog window shown in Figure 19b opens up. Enter a file name with any extension you choose.   

 

Figure 19b: Provide a filename, with an extension of your choice, for the binary file to be written to.  

Press the Save button. The window shown in Figure 19c will open up. Choose the Raw Float 
option for the binary file type. The default option is RG , so you need to scroll up to choose the 
Raw Float option. Click on Create Binary File . 

 

Figure 19c: Select the Raw Float option and click on Create Binary File . 
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Now open up the next SEG-Y file to be combined using the Open seismic records option under 
Vspect Process menu. From the window that displays the SEGY traces, choose the Append to 
Binary File option as shown in Figure 19d.  

 

Figure 19d: After reading in the next file to be combined, choose Append to Binary File option.  

A dialog window will open up. Choose the same file name that was used to create the binary file for 
the 1st record. The 2nd record will be appended to the 1st one. As before, choose Raw Float for the 
binary file type (Figure 19e) and click on Append Binary File to append the second record to the 
first one.  

 

Figure 19e: Choose the Raw Float option and click Append Binary File .   

Repeat this process for the remaining SEGY files, each time appending the binary file to the existing 
binary file. Make sure you choose the Raw Float option for the binary file type each time.  

While displaying any one of these SEGY files, make sure you save the plot parameters. This will 
allow you to display the appended file properly.  To do so, choose Plot Parameters from the Edit 
menu in the window that displays any one of the SEGY file as shown in Figure 19f.  
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Figure 19f: Select Plot Parameters option from the Edit menu  

Now click on Save Parameter File under the File menu in the parameter window that opens up 
(Figure 19g) and save the parameter file (Figure 19h).  

 

Figure 19g: Select the Save Parameter File to save the plot parameters to a file.  

Once you have appended all the files and created a new binary file, you can read it back in. To do so, 
use Step 1: Open Seismic Records option under Vspect Process. Select the combined binary 
file. Set the Binary File Type to Raw Float . You also need to set the following as shown in 
Figure 19i:  

Elements per vector = Total recording time / sample interval. For example, if the total recording time    
is 30 seconds and sampling interval is 2ms, then elements per vector = 15000 

Vectors per plane     = Number of channels per record (all traces recorded NOT the ones analyzed). 
Number of planes    = Number of records that were combined.  
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Once the data is read in displayed, you can adjust the plot parameters by reading in the parameter 
file saved in Figure 19h. To do this select the Apply Parameter File option under the Edit menu 
from the window that displays the records (Figure 19j) and read in the saved parameter file (plot.par 
in this case). 

 

Figure 19h: Save the plot parameters to a file. 

 

Figure 19i: Read in the combined SEG-Y file by selecting the Raw Float option for the binary file 
type and entering the correct values for elements per vector, vectors per plane, and number of planes. 

Make sure the Raw Float 
option is selected 

Check the number of channels 
(traces) to be analyzed 

Number of samples per trace 
= (total time) / (sample rate), where 
the units for both are same Total number of traces (channels) 

per record. Note that this number 
should be all the traces that are 
recorded and NOT just the ones 
being analyzed 

Number of files (records) being 
imported 
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Figure 19j: Render the data properly, by applying the parameter file saved in an earlier step.  

Now all the records should be displayed properly as separate planes and the Vspect processing can 
be continued.  

3.2 Step 2: Pre-processing the Data  

The next step in the SeisOpt ReMi Vspect analysis is pre-processing (Figure 20) the imported SEG-
Y data. This step is not necessary but is useful to do it. It does a trace-equalization gain and 
centering of all the traces in the records.  

 

Figure 20: Pre-processing of imported microtremor data  

Trace-equalization gain includes applying an automatic gain control whose length equals the number 
of time samples per traces, on all the traces. The centering function averages out any deviations or 
spikes in the data. Most records will provide a more coherent velocity spectrum if a trace-
equalization gain is applied first. This prevents high-amplitude near-offset traces from dominating 
the spectra. Once the pre-processing is completed, the pre-processed data (Figure 21) will be 
displayed in the same window as the original data. The title bar on this window will indicate that the 
process has been completed by displaying 

 

SeisOpt® ReMi V3.0 Vspect: SEG-Y filename + Step 
2 .   
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Figure 21: Data shown in Figure 15 after Step 2, pre-processing  

3.2.1 Writing out Pre-Processed Data to disk   

If you wish to save the pre-processed data, and save it to disk, use the Write Binary File under 
the File menu (Figure 22).   

 

Figure 22: Use the Write Binary File option under the File menu to write out the pre-processed 
data in SEG-Y format 

Provide the desired file name, making sure not to overwrite any existing files in the directory, in the 
dialog window with a .SGY extension, since the output file will have be in the SEG-Y format.  
Choose the SEG-Y option for the binary file type and 32-bit integer for the trace data type 
(Figure 23). Click on Create Binary File  button to save the file to disk.  

 

Figure 23: Select SEG-Y for the file type and 32-bit integer for the data type and click Create Binary 
File to write out the file 

Title bar indicates the 
processing stage 
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3.3 Step 3: Erase or Apply Geometry  

The next step is to enter the survey or erase the geometry present in the trace headers of the 
microtremor data. Choose Step 3: Erase or Apply Geometry item from the Vspect Process 
menu (Figure 24) on the window that has the displayed data.  

 

Figure 24: Choose Step 3 to erase or apply geometry to the microtremor data  

The window shown in Figure 25 will open. Make sure all the buttons appear as shown. If they do 
not, use the mouse, drag the lower right hand corner of the window and make it longer so all the 
buttons are visible.   

3.3.1 Erasing Geometry from the Trace Headers: Recommended for typical ReMi survey  

 

Figure 25: SeisOpt ReMi Vspect geometry tool. It is recommended that for a typical refraction 
microtremor survey, all geometry information contained in headers be erased by pressing the Erase 

All button 

Click to erase all geometry 
information in header. 
Recommended for survey 
lines that are straight or those 
that do not deviate by more 
that 5% from a straight line 

Enter geometry (Section 3.3.2) 
and click to apply. Used for 
crooked lines or lines with large 
elevation changes 
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For a typical ReMi survey, with approximately evenly spaced geophones and relatively straight line 
with gradual elevation changes, it is recommended that the geometry information contained in the 
trace headers be erased. This is done by clicking on the Erase All button in the window shown in 
Figure 25. The dialog window shown in Figure 26 will open up. Click OK for the geometry 
information to be erased. This procedure is recommended when the survey line does not deviate by 
more than 5% of the length of the line (for example, 10m for a 200m long line) or if the elevation 
change is gradual and not more than 5% of the total length of the line.   

 

Figure 26: The message window above appears. Click OK to erase all geometry information  

3.3.2 Applying Geometry to Trace Headers for Crooked line ReMi survey  

If the survey line is very crooked and there are rapid elevation changes then the correct geometry 
must be applied. To do so, the user needs to create the observer and surveyor's reports in plain text 
using Wordpad and copy and paste the text into the text area of the Geometry tool (Figure 25).   

First, create an observer's report according to the format given in the tool. You will need one line of 
observer's report text per record, in the order the records were read from the SEG-Y file. For 
example, if the data has 11 records (noise gathers) each having 36 channels and the stations are 
numbered 1 to 36 then the observer's report will have the following lines:   

1 1 1 1 36 
2 1 1 1 36 
3 1 1 1 36 
4 1 1 1 36 
5 1 1 1 36 
6 1 1 1 36 
7 1 1 1 36 
8 1 1 1 36 
9 1 1 1 36 
10 1 1 1 36 
11 1 1 1 36   

Copy it to the clipboard from the text editor (like Wordpad) and paste it to the Geometry tool's text 
area. Make sure the Type of Input Geometry is set to Observer's Report (Figure 27) and click the 

Apply button below.  
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Figure 27: Enter the information for each record contained in the file and click Apply to apply the 
observer s report.  

Next, create a surveyor s report or station coordinates list according to the format given in the tool. 
You will need one line of station coordinate text per record, in any order. Note that there are two 
orders for the coordinate text accepted (N-X-Y-Z or N-Z-Y-X). The station numbers in the 
observer's report and surveyor's report must match. For example, if you choose the (N-X-Y-Z) 
option then the surveyor s information will look like the one below for a 36-channel survey and with 
geophone spacing 10 feet and elevation along the profile is flat.  

1 0.0 0.0 0.0  
2 10.0 0.0 0.0  
3 20.0 0.0 0.0  
4 30.0 0.0 0.0  
5 40.0 0.0 0.0  
6 50.0 0.0 0.0  
7 60.0 0.0 0.0  
8 70.0 0.0 0.0  
9 80.0 0.0 0.0  
10 90.0 0.0 0.0  
11 100.0 0.0 0.0  
12 110.0 0.0 0.0  
13 120.0 0.0 0.0  
14 130.0 0.0 0.0  
15 140.0 0.0 0.0  
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16 150.0 0.0 0.0  
17 160.0 0.0 0.0  
18 170.0 0.0 0.0  
19 180.0 0.0 0.0  
20 190.0 0.0 0.0  
21 200.0 0.0 0.0 
22 210.0 0.0 0.0 
23 220.0 0.0 0.0 
24 230.0 0.0 0.0 
25 240.0 0.0 0.0 
26 250.0 0.0 0.0 
27 260.0 0.0 0.0 
28 270.0 0.0 0.0 
29 280.0 0.0 0.0 
30 290.0 0.0 0.0 
31 300.0 0.0 0.0 
32 310.0 0.0 0.0 
33 320.0 0.0 0.0 
34 330.0 0.0 0.0 
35 340.0 0.0 0.0 
36 350.0 0.0 0.0     

 

Figure 28: Enter the coordinates for each geophone location and click Apply to apply the surveyor s 
report. 

Station ID (N)        X          Y        Z  
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Paste it to the text area of the Geometry tool. Make sure the Type of Input Geometry is set to the 
appropriate Station Coordinates option, that the Unit System is set according to your input 
units, and click the Apply button at the bottom of the Geometry tool (Figure 28). Close the 
geometry tool by clicking the Close button.  

To get more detailed information on what the observer's and surveyor's reports are, select the 
appropriate entry from Type of Input Geometry above the text field using the pull-down menu 
(Figure 29), and click the Show Format button at the bottom of the window.  

 

Figure 29: Choose the type of input geometry and click Show Format to see the format of the input 
files needed to apply the geometry  

3.4 Step 4: Computing the velocity spectrum for each record: p-f transformation of the data  

Once the geometry has been erased (or entered for a very crooked line), the next step is to compute 
the velocity spectrum. This process involves computing a surface-wave, phase-velocity dispersion 
spectral-ratio image by p-tau and Fourier transform across all vectors. This is described in detail in 
Louie (2001, see Section 1.0). The resulting image will be in the slowness-frequency (p-f) domain.  

To start the process, choose Step 4: Compute p-f of Each Record from the Vspect Process 
menu (Figure 30) on the window on which the geometry process (Step 3) was done. To make sure, 
verify that the title bar on the window displays SeisOpt® ReMi V3.0 Vspect: SEG-Y filename+ 
Step 2, 3 (Figure 30).   

 

Figure 30: Choose Step 4: Compute p-f of Each Record to start the velocity spectrum calculation 
of each record. Make sure you perform this action on the window which displays the data and has had 

Step 3 applied to it. 
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This will perform the p-f transformation on each plane or record of the data sets. For example, for 
this demo data (RM2011.sgy), each of the 11records (RM2011 to RM2021) will be transformed 
individually.  

3.4.1 Setting Parameters and Starting ReMi Vspect Processing  

   

Figure 31: Set the parameters and click the vspect to start computing the p-f image for each record  

On choosing this step, the dialog window shown in Figure 31 will open up. Note that if the geometry 
has been entered correctly (see Section 3.3.2) then the window shown in Figure 31 will not have the 
dx entry; it will be automatically read in from the trace header information. Hence, it is important 

to enter the geometry correctly. If you are unsure about the geometry, it is recommended that it be 
erased (see Section 3.3.1) from the trace headers and enter and average geophone spacing before 
performing the Vspect processing.  

The settings in the dialog window are as follows:  

 

dt is the time sampling interval in seconds. For this example, it was 2ms (0.002 s) 

 

dx is the geophone spacing in meters. For this example, the spacing was 10 feet or 3.048 
meters. 

 

Fmax is the maximum frequency you are interested in analyzing, in hertz. The default 25 
Hz is the maximum used in analyzing data from 8-Hz geophones, and gives some 
resolution of velocities in the upper few meters. If you had used higher frequency phones 
and were interested in velocities in the uppermost meter, you might use a higher value for 
Fmax. Conversely, if you had data from lower-frequency geophones spread over larger 

Geophone spacing 
should be entered in 
meters 

Expected minimum velocity in 
the investigation area in m/s. It 
sets the axis limits of the p-f 
image and can be changed if it 
is too low or too high. 

Sampling interval, in 
seconds of the data. 

 

Maximum analysis frequency 
for the p-f transformation. 
Can be changed if not 
adequate or if too large, based 
on the p-f image. 

 

Select for noise records or 
noise and source combined 

Choose for shots recorded in 
the forward direction only 
(source near 1st geophone) 

Choose for shots recorded in 
the reverse direction only 
(source near last geophone) 
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offsets you might make Fmax lower. Note that these values can be changed and Step 4 
rerun, if the energy is observed at higher frequencies.  

 
Vmin is the minimum apparent or phase velocity your record might show. 200 m/s is 
default. It is useful to change this to 100 m/s or, as in this example, to 50 m/s. Once 
again, this value can be changed after the initial run. 

 
Np is the number of different slowness to include in the analysis. This defaults to 48 and 
usually a higher number results in increase of slowness resolution of higher velocities. 
However, slowness resolution is a complicated function of frequency, the number of 
traces, their spacing, and the total offset range. Hence, in most cases, the default value 
should be sufficient.  

 

Analyze: 

 

All Directions: Use this option when computing the p-f transformation of noise 
only or noise and source records . This assumes surface waves are coming from 
all directions with relation to the ReMi acquisition array. Note that if you  are 
analyzing records that might contain both noise and source induced energy, then 
this option should be used. 

 

Forward Only: Use this option when computing the dispersion curve for records 
that were collected using a source that is located near the first geophone 

 

Reverse Only: Use this option when computing the p-f image for records that 
were collected using a source that was located near the last geophone in the ReMi 
array.  

Once the parameters are set, click the vspect button to start the wavefield (p-f) transformation. A 
moderate-sized record can take a couple of minutes and a multi-record volume several.  
The progress will be indicated on the original MS-DOS or command window (Figure 32). Once the 
computing is completed and the velocity spectrum calculated, the window displaying the p-f image 
(Figure 33) will open up. Note that this is an entirely new window, and it is safe to close all other 
ReMi Vspect windows by clicking Close Window option under the File menu.   

 

Figure 32: The progress of the p-f transformation will be displayed in the MS-DOS window 

Vspect processing 
progress indicator 
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3.4.2 Visualizing Results of ReMi Vspect Processing: The Velocity Spectrum (p-f image)  

Once the vspect processing is completed, a window displaying the p-f image will open up. We 
are looking for trends of high spectral ratio that slope down to the right, giving lower phase 
velocities at higher frequencies, as is typical of surface-wave dispersion. 

 

Figure 33: On completion of the computation the window displaying the velocity spectrum for each 
record will be open up 

 

Figure 34: Step 4 computes the p-f image (velocity spectrum) for each individual record and is stored in 
individual planes. Use the scroll bar to view each one. 

Use the scroll bar to 
view p-f images for 
each processed noise 
record 

Cursor displays the 
(frequency, 
slowness, velocity) 
at each location 

Click animate to view 
all planes in the image 

Surface wave dispersion amplitudes always trend 
from the upper left corner to the lower right of the 
p-f image. 

Artifacts due to truncation 
and transformation of 
other phases do not have 
the same trend as the 
dispersion curve 

Maximum frequency 
value entered in the 
Vspect processing 
window 

Maximum slowness = 
Inverse of the minimum 
velocity value entered in 
the Vspect processing 
window
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The velocity spectrum is calculated for each record and so the p-f image (Figure 33) will have the 
same number of planes as the number of records in the data set, with the p-f image for each record 
stored in separate planes. Like for the data set display (Section 3.1.2) click on the Animate button 
to go through all the planes of the image. Use the scroll bar on the top to look at each image 
individually.  

Depending on the level of noise and its frequency content, each data, the p-f image (velocity 
spectrum) will be different for each record. For example, Figure 34 shows the p-f image of the 
seventh record (plane index 6) of the data set. The p-f image for each record is stored in different 
planes. If the seismic record has 11 records (as in this case) the p-f image will have 11 planes (Plane 
Index 0 to Plane Index 10) corresponding to the velocity spectrum from data sets RM2011 to 
RM2021 (in this case).  

The image is rendered with the frequency (in Hz) plotted along the horizontal (x) axis and the 
slowness (in seconds/meter, inverse of velocity) plotted down the vertical (y) axis. The origin (0, 0) 
of the image is the top left-hand corner. Since the highest frequency we used for the analysis was 35 
Hz, the frequency scale goes from 0 Hz to 35 Hz. Since 50 m/s was the lowest velocity used (Figure 
31), the slowness goes from 0 s/m to 0.02 s/m (1/50). The horizontal and vertical axes are linear in 
frequency and slowness, respectively. Consequently, the vertical axis is nonlinear in velocity. For 
instance, halfway down the plot at the left would be at half the slowness, 0.01 s/m, or 100 m/s; a 
quarter of the way down would be 0.005 s/m, or 200 m/s; and so on. The top row of the plot 
represents infinite velocity or, an arrival simultaneous at all the geophones.  

Details about how to pick the dispersion curve from the p-f image are given in Section 3.6. The 
important thing to note is that the Rayleigh wave dispersion trends from the top left to the lower 
right, while the aliasing and wavefield truncation artifacts track from left to right.  

3.5 Step 5: Combining Individual p-f Records into one Image  

The next step in the ReMi Vspect processing sequence is to combine the p-f image created for each 
record into one image. This can be achieved by choosing Step 5: Combine Record p-fs from 
the Vspect Process menu (Figure 35). The window shown in Figure 35a will open up. The user 
has the option of either using all the records or choosing the ones to be used to create the combined 
p-f image. To use all the records, click on the Use all planes radio button and click Ok . To select 
the records to be used in the summation, click on Use selected planes and choose the planes or 
records to be used by keeping the Ctrl key pressed while clicking on the appropriate Planes 
(Figure 35b). Remember that Plane 0 corresponds to Plane 0 in the p-f volume created during 
Step 4 (Figure 34), Plane 1 corresponds to Plane 1 of the p-f image and so on. The combined p-f 
image shown in Figure 35b was created using planes 0, 4, 6, and 8. When you make the selection, 
make sure that the desired plane is highlighted in blue and the Ctrl key is pressed down when 
selecting multiple planes.  

The option to choose the pf images that go into the combined image allows the user to exclude 
records that might have incoherent dispersion response or ones that show too many artifacts masking 
the continuity of the dispersion energy. For example, in the demo, only four out of the eleven records 
seem to have a dispersion curve that was coherent and continuous across a wide frequency band. 
Consequently only those four were used to produce the combined pf image. 
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Figure 35: Choose Combine Record p-fs.. to combine individual p-f images into one image.  

 

Figure 35a: Choose either all records or select the records to be used to create the combined p-f image. 
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Figure 35b: Planes 0, 4, 6 and 8 were selected to produce the image shown in Figure 36.  

 

Figure 36: Step 5 combines the individual wavefield transformed images for each microtremor record 
into one p-f image. In this example, planes 0, 4, 6, and 8 were used to create this image.  

ReMi Vspect will stack and sum the individual velocity spectrum into a single p-f image (Figure 36). 
Examine the individual p-f images (Figure 34) and the combined one and choose the one that shows 
the Rayleigh wave dispersion the best. That is look for the trend of warm colors that go from the 
upper-left part of the image to the lower right. We are looking for trends of high spectral ratio that 
slope down to the right, giving lower phase velocities at higher frequencies, as is typical of surface-
wave dispersion. The color palette used in Figure 36 show the higher spectral ratios as warmer 
colors. In some cases, an individual image will show a larger amplitude trend than the combined 
one.  

3.6 Step 6: Pick and Save Dispersion  

After choosing the p-f image that displays the most coherent Rayleigh-wave dispersion, the next step 
is to pick the dispersion curve and save the picks for input into the interactive velocity-modeling 
module, SeisOpt ReMi Disper.   
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3.6.1 Picking the Dispersion Curve  

The following steps describe the picking procedure   

1. The first step in picking the dispersion curve is to identify the normal-mode dispersion trend, 
down to the right (starting from the upper left) and distinct from the aliasing and wavefield-
transformation truncation artifact trends, which are down to the left. Make sure you are following 
the trend of the high spectral-ratio band that has the lowest velocity, or the highest slowness. 
That is the trend that is towards the bottom of the image. Note the velocity and frequency ranges 
of the identifiable dispersion trend.  

2. It is sometimes useful to magnify the image using the Zoom options under the View menu 
(Figure 37).  

 

Figure 37: Choose an appropriate Zoom percentage to magnify or shrink the p-f image.   

3. Pick several frequency-velocity pairs along the trend by left-clicking the mouse on the image 
(Figure 38)  
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Figure 38: Window showing dispersion picks made on the p-f (velocity spectrum) image.  

4. While picking microtremor records, try to pick the lowest energy bound of the high-amplitude 
(high spectral ratio s) trend. This stays closest to the real velocities, and below the higher 
apparent velocities of waves traveling not along but obliquely to the geophone array. 

5. While picking follow the zone where the warmer colors start to blend with the cooler ones (the 
blue-green color).  

6. It is not necessary that only one pick have to be made for a particular frequency. You can make 
more than one slowness pick for any given frequency. The range of slowness will give a bound 
on the velocities that are modeled. For example note that the picks in Figure 38 have some 
scatter to them. Since SeisOpt ReMi Disper determines the average shear-wave velocity, the 
picks do not have to be very accurate.  

7. Change the color palette to Vspect to see if this defines the transition better. To change the 
color palette, do the following: 

 

Select Plot Parameters option from the Edit menu (Figure 39). 

 

Choose Vspect color palette as shown in Figure 40. 

 

Click Apply Changes to render the image shown in Figure 41. 

 

If you wish to go back to the original color palette, choose Topographic, no clip and 
click Apply Changes .  

Do not pick the 
dispersion curve if it 
does not have strong 
amplitudes or if it 
within the area of the 
image that has artifacts 

Pick the transition between green and 
light blue color. Render the image 
using the Vspect color scale to see 
if the transition is rendered more 
clearly 

Pick the trend of 
the curve
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Figure 39: Select Plot Parameters from the Edit menu to bring up the plot properties window.  

 

Figure 40: Choose Vspect as shown above. To go back to the original color palette choose 
Topographic, no Clip option.  
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Figure 41: p-f image rendered using the Vspect color palette. Depending on the frequency and 
amplitude content in the noise records, this color palette will provide a better rendering of the 

transition from the high to low spectral ratios that need to be picked.  

8. It is better to be conservative while picking the data. That is, do not attempt make picks in areas 
where the warmer colors are absent (lack of high spectral ratio) or where there are gaps in the 
trend.  

9. On the other hand, if there is distinct kink in the dispersion curve, and it is present in all the p-f 
images of the data set, then it probably implies the presence of a high or low velocity layer, 
depending on the shape of the kink (see Figure 41a).  

Pick the transition olive green and 
dark blue when image is rendered 
using the Vspect color palette. It 
is recommended that both palettes be 
used to determine the best picking 
parameters for a particular data set. 
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Figure 41a: Example p-f image showing a kink in the dispersion curve indicative of a velocity 
reversal. 

10. If you are picking p-f images created from a source (Forward Only or Reverse Only options used 
for Analysis, see Section 3.4.1), then you need to pick the peak of the dispersion curve as shown 
in Figure 41b.  

 

Figure 41b: When picking the p-f image generated from using sources, then the picks need to be made 
along the peak amplitude and not the low-energy bound.  

11. Save the p-f image as a binary file (.SGY) using the Write Binary File ´option under the 
File menu. See Section 3.2.1 for details. 

A kink in the dispersion 
curve is often indicative of 
presence of velocity 
reversal in the subsurface. 

Pick the peak amplitude of the dispersion curve 
created by the p-f transformation of records 
generated using a source. These images should 
have created using the Forward Only or Reverse 
Only options during Vspect processing 
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12. Optim recommends and encourages users to send their first data set and any difficult data set to 

support@optimsoftware.com. We will perform the analysis and train you on how to pick and/or 
verify whether the picks you made are correct.  

3.6.2 Exporting and Saving Picks  

Now that the picks have been made, the next step is to export and save them to a file. These picks 
can then be imported into the SeisOpt ReMi Disper module (Section 4.0) for interactive modeling of 
the one-dimensional shear-wave velocity.  

To export the picks choose Pick and Save Dispersion option from the Vspect Process menu 
(Figure 42). This will open up the pick window shown in Figure 43.   

 

Figure 42: Choose the Pick window option to display and save the dispersion picks.  

Click on the Save button to bring up the dialog box shown in Figure 44. Choose a file name for 
the picks. Giving it a  .txt extension will allow the file to be viewed using Wordpad or Notepad. 
Clicking on Erase All will erase all the picks. The picks that are displayed in the window are 
ordered according to the order the picks were made. You can delete any unwanted picks by 
highlighting it and clicking the keyboard Delete button (Figure 43a). When deleting picks, make 
sure that are no blank lines (Figure 43b) between pick entries in the pick window. It is recommended 
that it is best to erase all the picks and start over if you are unsure of any picks. The best way to pick 
the dispersion curve is to follow the trend in one sitting.   

Once the picks have been saved, you are now ready to perform interactive modeling of the one-
dimensional shear wave velocities using the SeisOpt ReMi Disper module.  
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Figure 43: Pick window showing the dispersion curve picks made on the p-f (velocity spectrum) image.  

      

 

Figure 43(a): Select the picks to be deleted and click Delete to erase them. When deleting, make sure 
there are no blank lines between entries as shown on the right (b). 

 

Figure 44: Save the pick file. This can be imported into the SeisOpt ReMi Disper module for interactive 
modeling of one-dimensional shear-wave velocities. 
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3.7 Making Report Quality Output of Velocity Spectrum Image  

SeisOpt ReMi allows the user to write out the images rendered either as a PostScript (.ps extension) 
file or as a JPEG file.  It outputs the image is displayed in the ReMiVspect window.   

So, if you wish to plot the p-f image with the picks you have made on it, then you should use the 
Write PostScript File option or the Write JPEG File under the File menu before you 

close this window.  

The default plot parameters used to render the velocity spectrum (p-f image) can be viewed and 
edited by choosing the Plot Parameters option from the Edit menu (Figure 39 and 40). This 
window is similar to the plot parameter window for displaying and plotting the microtremor records. 
See Section 3.1.3 for a description of each parameter in the window.  One can change the title of the 
plot or the axes if desired. The aspect ratio and the color palette can also be changed. The following 
sections describe how to create report quality output of the p-f image, with our without the picks.  

3.7.1 Creating Output Velocity Spectrum Image  

After setting the desired plot parameters as described in the previous section, there are two ways to 
create a file containing the image shown in Figure 39 that can output to a printer or imported into a 
report. The first option is to use the Write JPEG File option under the File menu (Figure 46) 
to write out the image in jpeg format (Figure 45). Make sure to provide a .jpg extension to the file 
name.  

 

Figure 45: Select Write JPEG File under the File menu to create a jpeg image of the p-f image 
with the picks.  
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The second option is to write out a PostScript file. PostScript format files can be read into programs 
such as Adobe Illustrator and Corel Draw (Version 7.0 or less).  This format is useful because, 
unlike other graphics formats, text and other elements of the image are preserved as discrete objects 
(e.g., text is still text, not a raster image of text), which makes subsequent editing and customization 
of these files very easy. To view and/or print these files a program capable of reading EPS format 
files is needed. If you do not have such a program, you can download a set of free ones, called 
GhostScript (Copyright © Aladdin Enterprises) and GSView (Copyright © 2000 Ghostgum 
Software Pty Ltd.), from www.cs.wisc.edu/~ghost/. GSView is the visual interface to GhostScript. It 
allows viewing, printing, and manipulating the PostScript file for importing into an MS-WORD 
document (see Section 3.7.1.1). GhostScript/GSView can also be used to convert the EPS file into 
BMP, GIF, PDF, and several other formats. In addition, a quick Internet search will reveal that there 
are several shareware programs available that allow EPS files to be converted to GIF or BMP format 
files.   

To write out a PostScript file, choose the Write PostScript File option from the File menu 
(Figure 46). A dialog window will open up. Choose an appropriate name with the .ps extension.  

 

Figure 46: Select the Write PostScript File to write out a PostScript file of the image. 

3.7.1.1 Importing PostScript files into an MS WORD document  

The PostScript file created above can be modified using the freeware program GhostScript/GSView 
and inserted into an MS-WORD document. Essentially, it involves using GSView to create an EPS 
file with a Windows Metafile or TIFF preview. Here are the steps to follow to do the above:  

1. Open the PostScript file (.ps) written out by ReMi Vspect using GSView. Click OK when 
warning messages come up. Do not click Ignore all DSC . 

2. Go to the Options menu and select EPS Clip and Show Bounding Box options (Figure 
46a). 

3. Make sure the Ignore DSC option is not selected. 
4. If the entire image is not displayed on the screen, go to Media menu and choose 11x17 

option or something appropriate so the entire image is visible. 
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Figure 46a: After opening the PostScript file using GSView, make sure the EPS Clip and Show 
Bounding Box options are set as shown above.  

5. Go to the File menu and select PS to EPS option (Figure 46b). 

 

Figure 46b: Choose PS to EPS and convert the PostScript image to Encapsulate PostScript format. 
6. Make sure the option Automatically calculate Bounding Box is selected as shown in Figure 

46c 

 

Figure 46c: Select the option Automatically calculate Bounding Box in the dialog box. 

Select EPS Clip and Show 
Bounding Box from this menu. 

Make sure this is 
not selected. 
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7. Provide a filename with the .eps extension.  
8. Read in the saved EPS file. 
9. You will notice that the Bounding Box (dashed box) now surrounds only the image. 
10. Now go to the Edit menu and choose Add EPS preview option, and select the preview 

type (Windows Metafile or TIFF is the best option) (Figure 46d).  

 

Figure 46d: Choose the preview format to be Windows Metafile or TIFF 6 uncompressed

   

Figure 46e: The Encapsulated PostScript (.EPS) file created can be viewed using GSView or imported 
into MS-WORD document.  

11. Provide a new file name for the EPS file with the preview. Make sure you type in the 
extension .eps for the file name. 

12. Save the file as an EPS file.  
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Now, you will be able to insert the EPS file saved in step 9 into an MS-Word document using the 
insert-picture option or sent to a printer directly from GSView.  

4.0 SeisOpt ReMi Disper module  

SeisOpt ReMi Disper uses an iterative dispersion-modeling algorithm based on the method described 
by Saito (1979) to model the dispersion picks made using ReMi Vspect module. Double-click on the 
ReMiDisper desktop icon (Figure 2b) to start the Disper module. The module consists of three 
separate windows shown in Figures 47, 48, and 49. The objective is to model the picked dispersion 
curve (red filled squares in Figure 48) by clicking and dragging the shear-wave velocity profiles (red 
lines in Figure 49) so that the calculated dispersion curve (blue lines in Figure 48) matches the picks 
(red squares). The control window (Figure 47) can be used to toggle between different units 
(meters/second or feet/second), control the depth of the model, and magnify the image to better view 
and model the variations in the dispersion curve.  

4.1 Description of ReMi Disper Module Windows  

The Disper module has three windows and they are described in detail in the following sections.  

4.1.1 Controls Window  

This will open up at the top left-hand corner of the screen (Figure 47). It contains functions that 
control the plot parameters of the other two windows, read / write functionality, and parameters that 
control the convergence and sampling criteria of the modeling algorithm. The following is a 
description of the parameters: 

 

Period:  

 

Min: Minimum period, in seconds, of the dispersion curve being modeled. This will 
control the horizontal  axis in the Dispersion Curve window (Figure 48).  

 

Max: Maximum period, in seconds, of the dispersion curve being modeled. This will 
control the extent of  horizontal axis in the Dispersion Curve window (Figure 48).  

 

No. Steps: This controls the number of steps in the calculated period. That is more the 
number of steps, smoother is the calculated dispersion curve (blue line) shown in 
Dispersion Curve window (Figure 48). The default value is 20, and usually this is 

sufficient for modeling picks made from a typical p-f image. But, if the user wishes to 
model slight variations, one could increase it to 100. Be aware that increasing the number 
of steps will increase the time to render each new dispersion curve. It is best to increase 
the number of steps after the dispersion curve has been fit and before the calculated 
dispersion curve is written out to disk (see Section 4.4). 

 

Velocity: 

 

Min: Minimum velocity of the model and dispersion curve. This will control the vertical 
axis of the Dispersion Curve window (Figure 48). Also, make sure this value is less 
than the minimum velocity used while performing the interactive velocity modeling in 
the Model Profiles window (Figure 49). Else, a root not found error will occur. The 
values are either in meters/second or feet/seconds, depending on the choice made by the 
user. 

 

Max: Maximum velocity of the model and dispersion curve. 

 

Step: This controls the convergence criteria of the modeling algorithm. In most cases, this 
will not have to be changed. The only scenario this may have to be changed is when the 
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velocities are very low (< 100m/s) and the interactive module fails to model the picked 
dispersion values very well. In this case, the step size can be decrease. We strongly 
recommend that you contact support@optimsoftware.com

 
in such cases for suggestions 

on how to model set this parameter. 

 
Calculate: 

 
Rayleigh Dispersion: This is the default option and must be the one used. This models the 
picked dispersion curve, using the Rayleigh-wave phase-velocity dispersion analysis 
criteria. The one-dimensional shear-wave velocity derived using this option will be closer 
to the real earth shear wave velocity. 

 

Quarter-Wave Approx.: This option models the picks assuming the quarter-wavelength 
approximation. That is, it assumes the average shear-wave velocity is approximately 
equal to the one-quarter of the dominant wavelength. This option should be used only for 
instructional purposes.  

 

Figure 47: Set parameters for interactive velocity modeling and dispersion curve plotting.  

 

Units: 
The user has the option to toggle between meters/second and feet/second. The default setting 
is to meters/second. The output velocity model will always be written out in the unit that was 
selected during the modeling process.  

 

Max Depth: 
This controls the maximum depth of the velocity model shown in the Model Profiles 
window (Figure 49). Make sure that this value is set to be greater than the deepest interface 
in the model. 

 

Auto-scale Model: 
Clicking this will automatically re-size both the Model Profiles and Dispersion Curve 
windows to fit the maximum and minimum velocity limits in the modeled data. 

 

Update Plots: 
Clicking this button will refresh the velocity models in the Model Profiles window and the 
dispersion curves in the Dispersion Curve window. 

 

Model Mode: 

Adjust bounds of the 
Dispersion Curve 

window 

Assumes P-wave velocities 
with Vp/Vs=1.73 

Use if P-wave velocities 
are known to obtain a 
more accurate shear-wave 
profile.

 

Sets maximum 
depth in the Model 
Profiles window 

Re-size Model 
Profiles window

 

Make sure this is 
toggled when 
modeling for Vs 
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o The Standard mode will display only the shear-wave velocity (red vertical line) and density 

(vertical blue line) for each layer. It assumes the P-wave velocities are about 1.73 times that 
of the shear-wave velocity (Poisson solid assumption). 

o The Advanced model will display the P-wave velocity (green vertical line) for each layer 
in addition to the shear-wave and density profiles. This mode can be used when P-wave 
velocities for the site are available either from refraction surveys or well log. If so, this will 
improve the accuracy of the modeled shear-wave profiles. 

 
Pull-down menus: 

Across the top of this window under the File menu are options to open (import) and save 
(export) the model and the dispersion curves. The Convert File options can be used to 
convert dispersion files created from other programs (like SASW) to format for ReMiDisper 
(Section 4.1.1a). Create 2D Profile option is to create a 2D profile from a series of 1D 
profiles. This will be explained in a later section. The Quit option is also under this menu.  

4.1.1a Importing dispersion picks from third party software  

The Convert File option under the File menu (Figure 47a) in the ReMi Controls window gives 
the user the ability to import dispersion picks made using other analysis software into SeisOpt ReMi 
Disper module for shear-wave velocity modeling.   

 

Figure 47a: Select the file type for converting dispersion picks made using other software for input into 
ReMi Disper module  

Currently, the following types of dispersion files can be read in and converted: 
1. SASW (no header) file: Dispersion picks output from SASW (Spectral Analysis of Surface 

Waves) software. It assumes the file has no header information and there is only a single 
dispersion curve in the file being converted. 

2. Velocity/Wavelength pair: ASCII file containing two columns, with the first column being 
velocities and the second column being wavelengths. 

3. Velocity/Frequency pair: ASCII file containing two columns, with the first column being 
velocities and the second column being frequencies. 

4. Velocity/Frequency/Wavelength: ASCII file containing three columns, with the first column 
being velocities, the second column being frequencies and the third being wavelengths.  

Select the appropriate option to bring the Browse window (Figure 47b).   

Choose this option 
and read in 
appropriate file for 
conversion 

Choose one of the 
following file types 
for conversion 
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Figure 47b: Choose the appropriate file for conversion  

The program will convert the input file into a dispersion file with extension _disper.txt which can 
be read into ReMi Disper.   

4.1.2 Dispersion Curve Window 

This window will open up below the Controls window. When first opened, this will have a blue 
line showing the modeled dispersion curve (Figure 48).   

 

Figure 48: Dispersion Curve window of the ReMi Disper module. This window displays the modeled 
and picked dispersion values. 

Unlike the p-f image (Figure 34), the horizontal axis in this plot is the period (inverse of the 
frequency) in seconds and the vertical axis is phase-velocity, in meters/second or feet/second, 
depending on the units chosen in the Controls window (see Section 4.1.1). The minimum velocity 
and minimum period (maximum frequency) are at the left lower corner of the plot. Velocities and 
period increase linearly in the vertical and horizontal direction, respectively. The maximum and 
minimum values of the period, frequency, and velocity are displayed on the screen. Changing the 
limits in the Control window (Figure 47, Section 4.1.1) can change these values. Moving the cursor 
anywhere in the window will display the frequency, period, and velocity values. When the picked 
dispersion values are imported into the ReMi Disper module, they will be displayed as filled red 

Cursor displays 
frequency, period, 
and velocity values 

Minimum & maximum 
values of the velocity axis   
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squares. The objective then is to match and overlay the blue line on top of the red squares. Section 
4.2 describes the modeling process in detail.  

4.1.3 Model Profiles Window  

Figure 49 shows the Model Profiles window. The window in the Standard model mode is shown 
on the left while the window in the Advanced mode is shown on the right. The default display is a 
three-layer model.  

             

 

Figure 49: Model Profiles window. This window is used to interactively model the one-dimensional 
shear-wave velocity of the subsurface to match the dispersion picks. The figure of the left is the window 

when used in the Standard mode while on the right is the default window when used in the 
Advanced model mode.  

 

Vertical red lines: These are the shear-wave velocities for each layer. The value is either in 
meters/second or feet/second and is set in the Controls window (Section 4.1.1). One can 
manipulate the velocity model by clicking on the line with the left mouse button and dragging 
the mouse over the plot with the left button held down. Each segment of the red line, indicating 
velocity of a particular layer, can be move independent of the other. As the velocity profile is 
being changed, the synthetic (calculated) dispersion curve (blue line in Figure 48) in the 

Layer 
interface 
depths. 
Changed 
by moving 
the black 
horizontal 
line up or 
down. 

 

Density 
values. 
Change by 
moving the 
blue line to 
the right or 
left 

Vp/Vs 
ratio. 
Default 
value is 
1.73. 
Change
s when 
P- or S-
wave 
velocity 
is 
changed 
indepen
-dent of 
each 
other 

Automatically calculates 
100ft average velocity and 
soil classification as 
defined by IBC 2000 

P-wave 
velocities. 
Change 
by 
moving 
the green 
line to the 

Hold SHIFT 
key down to 
move S-wave 
and P-wave 
profiles 
independent of 
each other

 

Click using left-mouse button 
& click anywhere in the 
window to add a layer interface

  

Click using left-mouse 
button & click on layer 
interface to be deleted

 

S-wave 
velocities. 
Change by 
moving the 
red line to the 
left or right. 
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Dispersion Curve window will change. The velocity values for each layer are displayed to the 

right of the red line and they change as the lines are moved (Figure 49). Note that in the 
Standard model mode only the red S-wave velocities appear. The modeling assumes the 

subsurface has a Vp/Vs ratio of 1.73. If the ratios are known to be different for the site under 
investigation or if reliable P-wave velocities are available from refraction surveys, logs, etc., then 
the Advanced model mode can be used. 

 
Horizontal black lines: These indicate the layer interface depths. Clicking the left mouse on any 
interface and dragging the mouse over the plot with the left mouse button held down will change 
the depth of the layer. The depth value is shown on top of each interface towards the left of the 
plot (Figure 49). 

 

Blue vertical line: The blue vertical line towards the left of the plot indicates the density within 
each layer. They are assumed to be of a constant density of 2.0 g/cc for all the layers. This can be 
changed if reliable density values are available. For most soil types it has been shown that 
density variations are within 5% to 10% of 2.0g/cc and these have negligible effect on the shear-
wave velocity profile. But, if density values are available they should be used for modeling the 
shear-wav velocity profile. 

 

Green vertical line: These are the P-wave velocities for each layer. The value is either in 
meters/second or feet/second and is set in the Controls window (Section 4.1.1). These appear 
only when the Advanced model mode is selected in the Controls window and should be used 
only when reliable P-wave velocity information is available (like from refraction surveys, logs, 
etc). Using accurate P-wave velocity will lead to a more accurate shear-wave (S-wave) velocity 
profile. One can manipulate the velocity model by clicking on the green line with the left mouse 
button and dragging the mouse over the plot with the left button held down. Each segment of the 
green line, indicating the P-wave velocity of a particular layer, can be moved independent of the 
other. Doing so, will alter the S-wave velocity also, keeping the Vp/Vs ratio constant at 1.73. To 
move either the P-wave or S-wave profile only, press and hold down the SHIFT button while 
using the left mouse button to move either the P-wave (green line) or S-wave (red line) profiles. 
Thus, layers with Vp/Vs ratios greater or less than 1.73 can be modeled.  

 

Add Layer button: The Add Layer button on the top left allows the user to add a layer 
interface to the model. To do so, left-click on the button and then left-click at the location where 
the layer has to be added. For example, to add a layer interface at, say depth of 59 m, left click 
on the Add Layer button and then left click at about 59 m within the Model Profiles 
window. The correct depth can be achieved by dragging the interface after it has been added. 

 

Delete Layer button: To delete a layer interface, left-click on the Delete Layer button and left-
click on the interface that has to be removed. 

 

Vs: The 100 ft average velocity is continuously calculated and display at the bottom of the plot 
window. This forms the basis for classifying the soil as per IBC 2000. The soil classification is 
also shown in the window. Important: There are situations when the soil classification may 
have to modified based on presence of low-velocities etc. Please consult a certified 
professional engineer before confirming the soil classification. ReMi only provides the 100 
feet average shear-velocity calculated as per IBC 2000.

  

4.2 Interactive Modeling using ReMi Disper  

The following steps enumerate how to perform interactive modeling using the Disper module:  

1. Open the dispersion pick file created during Step 6 of the Vspect Processing sequence 
(Section 3.6.2) using the Open Dispersion File under the File menu in the Controls 

http://www.optimsoftware.com


                                                                                                                                                                     Page 52 of 79 © Optim LLC 2004, www.optimsoftware.com

 
Window (Figure 50). You can also load the file using the Open Dispersion File under the 
File menu in the Dispersion Curve window. If you plan to model the velocity in units of 

feet/second, make sure you toggle the Units option to that in the Controls Window 
(Figure 53). It is recommended that the modeling be done using the Standard model mode 
first. If P-wave velocities are available, then the shear-wave velocities can be refined in the 
Advanced model mode.   

 

Figure 50: Choose the Open Dispersion File option to load the dispersion picks  

2. The dialog window shown in Figure 51 will open up. Choose the appropriate pick file that 
was save from the ReMi Vspect module (Section 3.6.2, Figure 44). For the demo data, 
this file is RMpicks.txt .  

 

Figure 51: Select the pick file that was created during Step 6 of the Vspect processing sequence.  

3. The dispersion picks will now be displayed as red filled squares in the Dispersion Curve 
window (Figure 52).  

Load the 
dispersion 
picks by 
selecting this 
option 

Use Standard mode for 
the initial modeling
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4. If you wish to model the velocities in feet/sec, toggle the Units option in the Controls 

Window to feet per second (Figure 53). The velocities displayed in the Model Profile 
(Figure 54a) and the Dispersion Curve window will change accordingly (Figure 54a). Note 
that the Velocity Step in the Controls Window will also change. It is recommended that 
this value not be changed during processing. The only time this might have to be changed is 
if the shear-wave velocities are very low (<100 m/s) and if the interactive modeling fails to 
fit the picked picks. If such a situation arises, contact support@optimsoftware.com

 
for 

suggestions.  

 

Figure 52: The dispersion picks are displayed as red filled squares in the Dispersion Curve window.  

 

Figure 53: Select feet, seconds to do the modeling in units of feet/second  

5. Now click and drag the velocity profile (vertical red lines in the Model Profiles window) 
and the layer interfaces (horizontal black lines in the Model Profiles window) until the 
modeled dispersion curve (blue line the Dispersion Curve window) overlay the dispersion 
picks (red filled squares). The RMS error that appears at the bottom right hand corner of the 
Dispersion Curve window is a quantitative estimate of the fit. Lower the error, better the fit 

for a particular data set. 

The name of 
dispersion picks 
file is displayed on 
the title bar 

Calculated Dispersion 
curve 

Dispersion picks 
saved from 
Vspect processing 
Step 6 is loaded 
for modeling  
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6. It is recommended that the modeling start from the top down. Take an iterative, top-down 

approach to interactively modeling the dispersion picks. Figures 54a, b, c, d, e, and f 
illustrate the steps involved in modeling. 

7.  First fit the lower periods (higher frequency) picks first, since they sample the shallow 
horizons. Since the shallow horizons are lower velocities associated with the top layer, keep 
changing the layer velocities and interface depth of the first layer until the first few picks 
(shorter period picks) are matched well (Figure 54a).  Change the velocity and the interface 
depth.  

8. Also increase the size of the Dispersion Curve window by dragging the right-lower corner. 
This will increase the spacing between the uploaded (red squares) picks, enabling them to be 
fit better.  

 

Figure 54a: The first step is to model the shorter-period picks. Adjust shallow layer velocity and 
interface depth so that the blue line matches the high-frequency picks (short period) red squares.  

9. Note that you can fit as few or as many of the picks in one step as you wish. Going for too 
few would result in many layers, while too many may result in too few layers. Try to model 
about one-third to one-fourth of the picks at one step, starting from the shortest period. You 
can fine-tune the fits later. 

10. Once the shorter period (higher frequency) picks are matched, then change the velocities an 
interface of the second layer until a few middle-period picks at the higher periods (lower 
frequencies) are matched. Figure 54b shows all three analyses windows from this step. 

11. Repeat this process until all the picks are matched (Figure 54c). Usually the last few, longer 
period, picks are least constrained, since the sample the deepest part of the model. There is 
bound to be trade-off between the layer velocity and the interface depth, especially for the 
deeper layers. 

Increase size of 
this window by 
dragging this 
corner

 

Fit the shortest 
period (highest 
frequency) picks 
first 

Adjust shallow 
layer velocity 
and layer 
interface depth 

Lower the RMS 
error better the 
fit between the 
blue line and red 
squares  
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12. Once you are satisfied with the picks, add a layer to the bottom of the model. Adjust the 

velocity of the deepest layer and the one above it and see if you can improve the picks.  

 

Figure 54b: The next step is try fitting the middle-period picks. Adjust the middle layer velocity and 
interface depth to achieve this.  

Fit the mid-period picks by 
adjusting middle layers 

http://www.optimsoftware.com


                                                                                                                                                                     Page 56 of 79 © Optim LLC 2004, www.optimsoftware.com

  

Figure 54c: Lastly fit the longer-period picks by adjusting the deeper layers  

 

Figure 54d: Decrease the Max Depth  parameter and the maximum velocity value so that the model 
profile is magnified in the Model Profiles window. The maximum period can also be adjusted to 

match the data available.  

Fit the longer period picks by 
adjusting the deeper layer 
parameters 

Add layers if needed 

Decrease the maximum depth of 
the model and the maximum 
period to zoom in to the model 
profiles and dispersion picks 

Note that the RMS error is 
now 10, whereas in Figure 
54a it was 186. 
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13. Once all the picks are fit, that is, when the error is as low as possible, the next step is to fine-

tune the model.  
14. Set the Period Min and Max bounds to values outside the range of periods in your picks. 

Move the cursor to the pick location to find out these values. For the dispersion picks shown 
in Figure 54c these might be 0.02 to 0.35 seconds. 

15. Set the Max Depth to a lower value, if needed. In this case it was set at 150 feet. 
16. Click on Auto-scale model to automatically scale the Dispersion Curve and Model 

Profiles window. 
17. Click on the Update Plots button to register these changes. Figure 54d shows the updated 

windows. 
18. Click and drag the lower-right corner of the Dispersion Curve window to enlarge it, if 

necessary. 
19. If you wish to fine tune the shallow layers and need to zoom in, decrease the Max Depth 

and the Max Period parameters. This will display the shallow layers in greater detail 
(Figure 54e) and adjust them to fit the high-frequency (low period) picks better, thus 
decreasing the overall RMS error.   

 

Figure 54e: Decrease Max Depth in Controls Window to zoom in to the shallow layers in order to 
fine tune them. 

Change maximum depth and 
maximum period to zoom in 
and model the shallow layers 
better 

This will be also 
written out to 
directory 
containing the 
picks

 

http://www.optimsoftware.com


                                                                                                                                                                     Page 58 of 79 © Optim LLC 2004, www.optimsoftware.com

  

Figure 54f: Once satisfied with fits, add a deeper layer with a velocity about two times greater than the 
layer above it and adjust to see the maximum depth of resolution provided by the dispersion picks.  

20. Unless you have good evidence for a velocity inversion, try not to introduce one. The 
governing criteria while modeling the picks should be that the simplest model that fits the 
data well is the best estimate of the average shear wave velocity. 

21. As you adjust depths and velocities, note that there may be a range of these parameters in 
each layer that seem to fit the dispersion data equally well. These become the 
indeterminacies of your data. There is trade-off between the thickness and velocity of for 
every layer. Try to find the two end-member combinations of large thickness and high 
velocity, and small thickness and low velocity, that both fit the data equally well. This will 
give you limits or bounds of the velocity model. 

22. To determined the maximum depth to which the dispersion picks can resolve the velocities 
do the following test: Add a layer with a velocity about two times greater than the deepest 
layer velocity. Now vary its depth slowly to see how it affects the picks. Determine the depth 
at which it stops affecting the picks.  Now take the average of this depth and the depth of 
layer above. This is approximately the deepest the picks can resolve shear-wave velocities to. 

23. The 100 ft average shear-wave velocity (Vs), along with the IBC 2000 (International 
Building Code) soil classification, is automatically calculated and displayed at the bottom of 
the Model Profiles window. This is also written out to a file called [name of the model 
file]_ibc.txt. If for example the model file is mod.txt , the IBC value will be written out to a 
file called mod.txt_ibc.txt in the same directory to which the model file was written.  

24. Keep in mind that SeisOpt ReMi calculates the average one-dimensional shear wave 
velocities, so the user does not have to fit every pick. The objective is to fit the general trend 
of the picks, with the blue line passing through the center of the picks, resulting in an average 
shear-wave velocity profile. It is best to introduce velocity reversals only if you have other 
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its depth to 
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depth-
resolution of 
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evidence suggesting its presence or if quite a few p-f images (velocity spectra, Figure 55) 
show velocity reversal signatures. 

25. Figure 55 shows an example velocity spectrum (p-f image) that shows a velocity reversal. 
Figure 55a and b show the picks and the model profiles that fit the dispersion picks. This data 
set shows a clear kink in the picked dispersion values (red squares) that is indicative of 
the presence of a high velocity layer and thus it is safe to model it as a velocity reversal. 

 

Figure 55: Example p-f image showing the dispersion picks for a model with velocity reversal.  

 

Figure 55a: Dispersion picks (red squares) made from the p-f image shown in Figure 55 and the fits 
(blue line) produced by the model shown in Figure 55b.  
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Figure 55b: Shear-wave velocity model with velocity reversal obtained by fitting the picks shown in 
Figure 55a.   

4.2.1 Using the Advanced Model Mode  

This version of ReMi allows the user to use P-wave velocity information, if available, to improve the 
accuracy of the modeled shear-wave profile.  

 

In the Standard model mode, SeisOpt ReMi Disper assumes that the Vp/Vs ratio is 1.73. 
This is may not be necessarily true for all soil types. For example very soft clays are known 
to have Vp/Vs ratios of over 5. 

 

If P-wave velocities for the site are known (from refraction surveys, logs, etc) then they can 
be used to model the shear-wave velocities better.  

 

To do so, select the Advanced model mode in the Controls Window (Figure 56). The P-
wave velocities for will be displayed as green lines.  

 

Click on Auto-Fit Model in the Controls window to adjust the Model Profile window so 
all the layer velocities are visible. As mentioned above, the default P-wave velocities have a 
Vp/Vs ration of 1.73.   
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Figure 56: Select the Advanced model mode in the Controls window to model the shear-wave 
velocity profile with P-wave velocity constraints.  

 

Now the P-wave velocity can be adjusted independent of the shear-wave velocity by holding 
down the SHIFT key and moving the green lines to the appropriate values for each layer 
using the left mouse button.  

 

You will notice that the fits, that is, the blue curve in the Dispersion window, will change 
for Vp/Vs ratios much different from 1.73.  

 

Keeping the P-wave velocities fixed (since they are known) adjust the shear-wave velocities 
so that the fit between the red squares and blue line is again satisfactory. 

 

One may also have to add more layers to account for the variations. Figure 57 shows a 
modified shear-wave profile, assuming P-wave velocities. Note that this is just for demo 
purposes  Vp/Vs ratios may not be as high as shown. 

 

Vp/Vs ratios can be used for determining Poisson s ratio and other soil properties.  
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Advanced 
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Click to re-size Model 
Profiles window 

http://www.optimsoftware.com


                                                                                                                                                                     Page 62 of 79 © Optim LLC 2004, www.optimsoftware.com

  

Figure 57: The shear-wave velocities need to adjusted to fit the picks based on the P-wave velocity 
information.  

4.3 Exporting the Model Profiles and Modeled Dispersion Curve  

Once the model has been derived, the next step is to save it to disk. To do so, choose the Save 
Model File option from the File menu (Figure 58). A dialog window opens up (Figure 59) 
where the file name for the model can be entered. Using a .txt extension for the model file will 
make it easy for it to be opened using a file editor like Notepad or Wordpad.  

The saved model can be read back into the ReMi Disper module, by using the Open Model File 
under the File menu (Figure 60). The model will be rendered in the Model Profiles window. 
Make sure you select the desired Units parameter when saving the model. The model file output by 
the ReMi Disper module writes depth and velocities in the selected units on the Controls window.  
The first line in the saved model file indicates whether it is in units of m,s or ft,s . The first 
column in the file is the depth of the layer, the second column is the density (in g/cc), third column 
are the P-wave velocities, and the fourth column is the shear-wave velocity of the layers. If the 
Standard model mode is used, the Vp values written out will be zero. The actual values will be 

output when the Advanced model mode is selected. When the model is saved, the IBC soil 
classification for the profile is also written out to a file. The file will have use the name of the model 
file as prefix follow by the suffix ibc.txt . So if the model file name is RMmodel.txt then the IBC 
soil classification will be written out to a file called RMmodel.txt_ibc.txt . This will be written out 
to the directory that contains the dispersion picks.  
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We get the same 
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Figure 58: Choose the Save Model File to save the one-dimensional velocity model to disk.  

 

Figure 59: Enter the file name for the model to be saved to. The IBC soil classification is written out to 
a file with a suffix ibc.txt to the directory that contains the dispersion picks.  

One can also save the modeled (calculated) dispersion curve (blue line in the Dispersion Curve 
window) to a file (Figure 61). This is useful if you wish to plot the picked dispersion curve against 
the calculated dispersion pick using MS-Excel (see Section 4.5). Note that if you increase the 
number of steps ( No. Steps ) parameter in the Controls window from the default 20 to 60 and 
click Update Plots , then more dispersion points will be calculated, resulting in a smoother 
calculated dispersion curve (blue line).   
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Figure 60: The saved model can be imported into ReMi Disper by using the Open Model File option 
under the File menu.  

 

Figure 61: Use the Save Dispersion File option to save the calculated dispersion picks (blue line in 
the Dispersion Curve window.  

4.4 Making Report Quality Output from the ReMi Disper Module  

Once the model and dispersion files are saved to a local disk, they can be imported into a 
spreadsheet program like MS-Excel to plot the profile and dispersion fits, respectively.   

4.4.1 Plotting the Model Profile  

The sample spreadsheet (RM_mod.xls) included in the demo sub-directory in the SeisOpt ReMi 
installation directory (C:\Optim\ReMiv30) (Figure 62) shows the model file after it has been 
imported into Excel. The first columns, which are the depths to the layer interfaces, have been 
modified to be negative, so the plots are rendered correctly. Next, use the graph module of MS-Excel 
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to plot the profile shown in Figure 63. Make sure to use space delimit option when cutting and 
pasting the RMmodel.txt (saved model file) file into the spreadsheet.  

 

Figure 62: Import the saved model file into MS-Excel to plot the one-dimensional shear-wave profile. 
This file (RMmod.xls) is included in the demo subdirectory.  

 

Figure 63: Plot of the one-dimensional shear-wave velocity created using MS-Excel. The spreadsheet is 
included in the demo subdirectory. 
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4.4.2 Plotting the Dispersion Curve  

In addition, one can plot the picked (red squares) versus calculated dispersion curve (blue lines) by 
importing the picked file (for the demo data, RMpicks.txt ) and the saved dispersion data. The MS-
Excel file RMcalcdis.xls (Figures 64a and 64b) included in the demo subdirectory shows the 
imported picks (numbers in black) and saved dispersion (numbers in red) file. The picked and saved 
dispersion values are in frequency (Hz) and slowness (seconds/meter). Use the spreadsheet functions 
to convert it to desired values you wish to plot. That is, if you wish to plot frequency versus 
Rayleigh-wave phase velocity, then convert slowness (for example, column E in dis.xls) to velocity 
(for example, column G in the dis.xls) by taking the inverse of the output slowness values. Similarly, 
frequency can be converted to period by taking its inverse (Period = 1/Frequency).   

 

Figure 64a: Import the dispersion picks file (RMpicks.txt in this case) into MS-Excel to plot the 
dispersion curve (Figure 65). The blue color filled columns are the imported picks. The Period and 

Velocity values are calculated. 
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Figure 64a: Import the calculated dispersion file (RMcalcdis.txt in this case) into MS-Excel to plot the 
dispersion curve (Figure 65). The blue color filled columns are the imported picks. The Period and 

Velocity values are calculated.   
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Figure 65: Dispersion curve plot created using the graph module of MS-Excel. The example file 
RM_dis.xls included in the demo directory produces this plot.  

 

Figure 66: Click on Quit to exit the ReMi Disper module.  

 

Figure 67: Click Yes to save model file or No to quit without saving. Click Cancel to continue 
using Disper.  

Use the Quit button under the File menu (Figure 66) to quit the ReMi Disper module. The dialog 
window shown in Figure 67 will open up. If you have not saved the model, click Yes and enter a 
model file name. Click Cancel if you wish to continue using ReMi Disper or No to quit without 
saving the model file.  
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5.0 Creating 2D Velocity Models Using SeisOpt ReMi  

The new version of SeisOpt ReMi allows the user to create 2D cross-section by analyzing traces 
recorded on groups of geophones deployed along the array. The software comes with the capability 
that allows the user to perform the Vspect analysis on groups of traces (for example, trace 1-6, 3-
8, and so on) and derive a 1D model for each group. Then the 1D models can be put together to 
create a 2D cross-section.   

Creating a 2D cross-section will allow the user to image the lateral variations in the shear-wave 
velocity. It can be very useful to map isolated low-velocity zones, get constraints on depth to higher-
velocity layers (for example, bedrock), map velocity discontinuities, like faults, and in general get 
constraints on velocity model obtained from standard refraction survey. Since ReMi can be done in 
noisy urban areas, the 2D image allows the user to get some constraints on velocities in areas where 
the high noise level would render a standard refraction survey useless.   

5.1 Importing and processing data for 2D analysis 
   

 

Figure 68: Import traces 1-6 for 2D analysis   
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The first step is to import data as described in Section 3.1.1 and 3.1.2. The objective to analyze 
groups of traces (channels) instead of processing data recorded at all the geophones at the same time. 
That is, only selected traces are imported and analyzed. In this example, the field data has 36 
channels. So for the 2D analysis, traces 1-6, 3-8, 5-10, 7-12, 9-14, 11-16, 13-18, 15-20, 17-22, 19-
24, 21-26, 23-28, 25-30, 27-32, 29-34, 31-36 are analyzed. A 1D model is derived for each group of 
traces. Then the 1D models are put together to obtain a 2D cross-section. It is recommended that at 
least 6 traces be used for analysis. The overlap of 70% of traces (4 traces in this case) gives the user 
a better control on the lateral velocity variation. If the subsurface velocities are expected to be layer-
cake, with little or no lateral variation, then more traces at a time and less overlap can be used for 
analysis. One consequence of using fewer traces is that the maximum offset is reduced. As a result 
the lower-frequencies in the pf image (Figure 70b) are not well defined. This, in turn, causes the 
depth of the velocity models obtained to be much less than when using all the traces. But, it is 
important to remember that most of the velocity variations do occur at shallow depths. So, the 2D 
image created will map the velocity variations were they occur the most.   

 

Figure 69: Traces 1-6 are read in and displayed  

As shown in Figure 68, traces 1-6 are read in. The first six traces are displayed in Figure 69. Next, 
use the ReMiVspect module and follow the steps described in Sections 3.2, 3.3, 3.4, 3.5 and 3.6 to 
create a pf image and pick the dispersion curve (Figures 70a and 70b).  When performing the 
Vspect processing on fewer traces, it is best to use the same parameters as those used when 

processing all the traces.  
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Figure 70a: Process the traces using the ReMiVspect module. It is easiest to use the same parameters 
used to process all the traces when processing groups of traces  

 

Figure 70b: pf image showing the picks for traces 1-6. Note that the fewer traces used causes the 
dispersion curve to be less well defined at the lower frequencies, consequently limiting the depth of the 

velocity model.  
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Next follow the steps outlines in Section 4.2 to generate a 1D model using the ReMiDisper 
module. The best procedure to model fewer traces is to start of with the 1D model generated using 
all the traces (used Open Model to read in the saved 1D model) and then adjust the layer velocities 
and layer interface depths until the model fits the picks (minimum RMS error). Since fewer traces 
are being used the maximum depth of the model will be less than the depth of the model obtained 
using all the traces. Consequently, as in this example, the deeper layer will probably not imaged 
(Figure 71).   

 

Figure 71: Picks are modeled using ReMiDisper module. Note that the maximum depth of constraint 
is now much less (about 60 feet) compared to when all traces are used (about 150 feet). Consequently 

the deepest layer is not imaged. 

 

Figure 72: Save the model to a file with numeric component. In this case, it is save to file 
RMmodel01.txt . 
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The next step is to save the model to a file that is named a certain way. It should have a numeric part 
to it, preferably to the end before the extension. For example, the model file can be called 
RMmodel01.txt , or Vs0001.txt or model_01.txt . The idea is to name the files sequentially for 

each set of traces being processed as one goes from lower to higher geophone numbers.   

In the above case, model derived by analyzing traces 1-6 is saved to file called RMmodel01.txt .  
Repeat the steps for traces 3-8, 5-10, 7-12, 9-14, 11-16, 13-18, 15-20, 17-22, 19-24, 21-26, 23-28, 
25-30, 27-32, 29-34, and 31-36. Models derived from each set should be saved to file that has the 
numeric value sequentially increasing with increasing geophone numbers. In this case the model 
files were called RMmodel02.txt , RMmodel03.txt , ,`RMmodel16.txt .  

5.2 Assembling a 2D Cross-section  

Once the 1D models for each set of traces have been derived, they can be assembled to create a 2D 
shear-wave velocity cross-section under the profile.  To do this, the saved model files have to be 
edited to enter the value of the horizontal distance of the midpoint of the traces being analyzed and 
the elevation, if any, at that location.   

For example, open RMmodel01.txt (Figure 73). Edit the first line and enter the horizontal distance 
and elevation of the midpoint of the traces being analyzed. Since the geophone spacing was 10 feet, 
the midpoint between trace 1, which is at 0 feet, and trace 6, which is at 50 feet, will be 25 feet. 
Enter the value 25.0 0.0 (since it is flat elevation) in the first line (Figure 73). Repeat this step for 
each of the saved model files, each time changing the horizontal distance and the elevation values. 
Figure 74 shows the change made for the last model file (traces 31-36, file RMmdoel16.txt ). The 
horizontal distance for this will be 325 feet.   

  

Figure 73: Saved model file for traces 1-6, RMmodel01.txt , is edited to enter the horizontal distance 
and elevation of the model location. Note that the location is the midpoint of the traces being analyzed. 
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Figure 74: Model file RMmodel16.txt is edited to include the location of the last set of traces that were 

analyzed (traces 31-36). 
It is also recommended that the maximum depth in the 1D profiles (last value in the 1st column, 
Figure 74), be edited so that it is the same in all the files. This will ensure that the 2D cross-section 
will be rendered properly.  

The next step is to read in the edited 1D model files and generate a 2D cross-section. Select the 
Create 2D profile option under the File menu from either the Controls window or the Model 

Profiles window (Figure 75).  

 

Figure 75: Choose the Create 2D Profile option from the File menu to start the 2D assembly process.  

The File browse window shown in Figure 76 will open up. As the title bar on the window 
indicates, choose the first 1D profile model file that will go into creating the 2D cross-section. In this 
example, the file is the edited file RMmodel01.txt . Select the file and click Open .    

 

Figure 76: Select the first 1D profile to be read in and click Open .  
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Another window will open up requesting the last 1D profile model file be chosen (Figure 77). Select 
the last file ( RMmodel16.txt in this example) and click Open . If the models have been 
successfully read in, the dialog window shown in Figure 78 will open. Note that the assembler will 
not work if the model files are not named sequentially and if the numeric component of the file 
name does not increment by 1.  

 

Figure 77: Select the last 1D profile to be read in to create the 2D cross-section.  

The dialog window shown in Figure 78 allows the user to set the following plotting parameters:  

 

Figure 78: Set the plot parameters in this window and click OK .  

 

Units: Use the pull-down menu to select the appropriate unit for the plot. These should be 
units that were used when saving the 1D model profiles. It can be km,km/s , m,m/s , of 
ft,ft/s . 
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Horizontal Distance: The module automatically estimates the minimum and maximum 
horizontal distances of the 2D cross-section. These values will be displayed in the min and 
max box. They can be changed to window out parts of the model to be displayed. The 
Samples box shows the number of samples used when interpolating between the each 1D 

profile. More the samples, smoother the model in the horizontal direction. 

 
Elevation: The maximum elevation is displayed in the max box and will be the top of the 
model (zero depth). The minimum elevation is the bottom of the model and should be less 
the maximum elevation value. Samples box shows the number of samples used when 
interpolating between the each 1D profile in depth. More the samples, smoother the model in 
depth. 

 

Velocity: The default maximum and minimum values in the velocity model are displayed in 
the window. The velocity limits can be changed to according to user needs.  

Figure 79, shows the 2D cross-section. One can click anywhere on the image to view the location 
and the velocity value. The amplitude scale can be adjusted to bring display the desired features 
better. In this case the maximum and minimum values were change to 1,500 ft/s and 300 ft/s to bring 
out the low-velocity shallow layer and higher velocity material to the right.  

 

Figure 79: 2D cross-section created along a 36-geophone array with 10 feet geophone spacing.  

 

Figure 80: Choose Change Settings to open the dialog window and change the plot parameters. Select 
Export as JPEG Image to save the model as a jpeg file and choose Export as ASCII File to save the 
write out the ASCII velocity values and its horizontal location and elevation within the subsurface.  

Click on the image to view 
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The plot parameter window (Figure 78) can be viewed by selecting Change Settings from the File 
menu in the 2-D Profile window (Figure 80). The plot settings can then be changed and the image 
rendered accordingly. Choosing the Export as JPEG Image option allows the user to save the 2D 
image as a jpeg file. The program also offers the option of saving the velocity grid as a 3-column 
ASCII file, with first column being the horizontal distance, second column being the elevation and 
third the velocity value at that location (Figure 81). This file can be imported into drawing programs 
like Surfer to create contoured images of the velocity model.  

 

Figure 81: ASCII velocity file saved using the Export ASCII file option under the File menu in the 2-
D profile window.  

6.0 Solutions to Possible Problems and Other Useful Information  

It is possible to encounter some problems while running SeisOpt ReMi software, mostly because of 
memory issues or using incorrect file formats. Below we list some trouble shooting tips.  

6.1 Authorizing the license  

SeisOpt ReMi will not run without a valid license and registration. Follow the steps outlined in 
Section 2.0.  

The licensing software used by ReMi uses hidden files to keep track of the license. If an unlimited 
license ever becomes disabled, it is probably because one or more of the hidden files was 
inadvertently removed, possibly by a hard-disk utility program. For example, this is known to 
happen when running Speed Disk, a de-fragmentation utility included in Symantec s Norton 
Utilities. This also happens while running Norton Anti-Virus Utility. Loss of these files will result in 
the loss of license to run SeisOpt ReMi   

To prevent these losses do the following: 

Horizontal 
distance 

Elevation Velocity value 
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1. Open Speed Disk, and choose File, Options, Customize, and Unmovable Files. 
2. Specify that the *.ENT, *.RST, .KEY, and.41S files cannot be moved.  

6.2 Transferring the license  

SeisOpt ReMi Vspect and Disper module license can be transferred from one computer to another. 
But the user will still have the Register ReMi by following the instructions in Section 2.0. The 
transfer process only transfers the licenses but not the registration. The transfer should be done 
before uninstalling SeisOpt ReMi on the old computer. Once the license has been transferred, 
SeisOpt ReMi will not run on the old computer. Here are the steps to follow for transferring the 
ReMi license from one computer to another:  

1. Install SeisOpt ReMi on new computer. 
2. Put a new floppy disk into the disk drive 
3. Click on the SeisOpt ReMi Disper desktop icon (Figure 2b). A license window will open. 
4. Go the License menu and choose Transfer in from another computer

 

5. The program imprints its registration on the disk. 
6. Now remove the floppy disk and put it into the old computer on which SeisOpt ReMi was 

installed. 
7. Start SeisOpt ReMi on the old computer and hit return when the Check License window 

comes up. 
8. A license window will open up. 
9. From the license window, go to License menu and choose Transfer Out of Computer . Supply 

the floppy disk path. 
10. Remove the floppy disk and go back to new computer. 
11. Click Transfer into Computer to complete the transfer and discard the intermediate imprint 

files on the floppy disk.  

6.3 Out of Memory error  

Memory shortage may cause large SEG-Y files not to be displayed by the ReMi Vspect module. If 
such a scenario arises, an Out of memory error message will be displayed on the console (MS-
DOS) window.  If this happens, send email to support@optimsoftware.com

 

mentioning the amount 
of RAM available on your PC. A replacement vspect and disper script will be sent to you for 
your use.  

6.4 Cannot Find Root Error  

This error might occur when the velocity limits for the model in the Controls window of the ReMi 
Disper module are set to be inside the limits of the profiles displayed in the Model Profiles 
window. For example, if the minimum velocity was set to be greater than minimum velocity in the 
profile and the maximum velocity less than the maximum velocity of the profile, then a Cannot 
find root error will appear in the Dispersion Curve window. The Model Profiles window will 
not display a velocity model (no red lines). To avoid this, make sure the velocity limits are outside 
the maximum and minimum velocities in the Model Profiles window.  

http://www.optimsoftware.com


© Optim LLC 2004, www.optimsoftware.com  Page 79 of 79

 
6.5 ReMi Disper Module: Shape of the Calculated Dispersion Curve   

As shown in the examples included in the manual, the calculated dispersion curve (blue line the 
Dispersion Curve

 
window) should be smooth. Sometimes, the curve might display sharp changes, 

especially towards the edge of the windows. This is an artifact of the limits placed on the velocity 
model, period, and maximum depth in the Controls Window of the Disper module. Change these 
and click Update . If it doesn t make any difference reload the dispersion curve and model file and 
re-render the calculated dispersion curve.  
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